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1. Introduction 
These programs were developed at CIMMYT for conducting field socioeconomic 

surveys by means of expand PDAs and expand PCs. The process of collecting data in 

the PDA or PC consists of designing the survey on the PC, taking the questions from 

the questionnaire, and programming them. This generates the template containing 

the questions in a file with extension .ssf. This file allows the socioeconomic survey 

form (SSF) for the PDA, as well as the SSF for the PC, to interpret the template and 

design the backbone of the questionnaire on the screen, capturing the survey data 

by means of a set of validation rules in the program. The survey tools are divided 

into two programs. 

1.1 Socioeconomic survey form programs 

1.1.1 Socioeconomic survey form for Pocket  

The Socioeconomic Survey Form (SSF) is a program designed for Pocket PCs. It runs 

with portable devices such as Pockets and Ultra-Mobile Personal Computers (UMPCs) 

with Windows Mobile as it operating system. To date, we have tested the SSF with 

Windows Mobile 2003 SE, and Windows Mobile 5.0, but not with later versions. 

You can build entry forms based on templates for entering new information and 

display or edit entered data. The number of questions you can enter is limited only 

by the capacity of the Pocket PC. In the forms, you record the information in XML 

files. With the SSF you can: 

 Enter new information and edit the existing data 

 Safely display the recorded data on a questionnaire.  

 Navigate easily through questionnaires. 

 Perform data entry with validation rules. 



1.1.2 Socioeconomic Survey Form for PC  

The Socioeconomic survey form for PC is a program designed for PCs. The 

application runs on desktop computers, laptops, and netbooks, and in general with 

any computer that has Microsoft Windows as its operatig system. To date, we have 

tested it with Windows 2000, XP, and Vista. 

It allows users to design templates for the Pocket and also for PC. The templates are 

files with XML syntax that the Socioeconomic Survey Form program reads and 

constructs so as to generate forms for entering data through controls such as text 

fields, boxes, radio buttons, and lists. The data introduced can be exported to 

different file formats such as CSV, SPSS1 or MS Excel. The templates have an *.ssf 

extension and the data captured is saved in the *.xml extension files with the same 

file name as the template files.  

With the SSF version for PC you can easily design forms for entry capture. Simply 

select the type of control you want to see in the capture form, place it where you 

want it on the screen and assign it some properties such as the text to display, 

capture value by default and validation rules. 

In general, SSF has the following characteristics: 

 It is free (requires no payment for use). 

 You create capture forms merely by dragging and dropping the field controls. 

 Easy handling of the design and data entry thanks to its user-friendly interface in 

a Windows environment. 

 Requires no prior programming or database expertise for designing the capture 

forms. 

 Allows for the creation of relational tables, simplifying the creation of large arrays 

or matrices. 

 WYSIWYG (What-You-See-Is-What-You-Get) view: The design of the form 

corresponds to the data entry form in your Pocket and PC. 

                                          
1 SPSS (Statistical Package for the Social Sciences): A software system for data management and analysis. SPSS may 
be used for many univariate and multivariate statistical analyses and has facilities for sorting and merging files and 
manipulating data. 
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 There is no limit to the number of controls set up in the capture form, or the size 

of the records, or the number of records in the database. The limits are set by 

the resources of the computer itself. 

 Different types of data entry or variables (alpha, numeric, dates, boolean) 

Although no previous knowledge of socio-economic surveys or similar programs is 

required, being familiar with the use of PDAs is useful, as well as experience using 

Windows Explorer on a PC, and the operation of the Pocket settings. For any 

reference, it is recommended you use the PDA's and PC’s own manual. 

The present manual is targeted to any user interested in conducting socioeconomic 

surveys through the Pocket and PCs. The manual covers fundamental aspects 

including the program installation and its requirements, and a brief step-by-step 

tutorial for the user to start exploring the main features of the programs. 

As a user, if you are only interested in conducting surveys, probably reading only the 

tutorial section will be enough. If you are a supervisor or administrator in charge of 

collecting the data from the questionnaire, you should go through the entire manual 

because to know all the program requirements and the installation in the Pocket and 

PC, for copying the files (data) from the Pocket to the PC (and vice versa), and to 

familiarize yourself with the template syntax to be able to modify it based on the 

changes made to the questionnaire. 

The latest version of this manual and examples to help you use the software can be 

downloaded from the CIMMYT website: 

http://www.cimmyt.org/english/docs/manual/seconsur 

1.2 Basic Requirements 

You will need a PC with a Microsoft Windows operating system (tested with Windows 

2000 and XP). The PC should have a minimum processor speed of 1 GHz. The PC 

must have the Microsoft .Net Framework 2.0 Redistributable Package (or greater) 

and Windows Installer 2.0 in order to be able to run the installation programs for 

Pocket and PC. If the computer system is Windows XP or Windows Server 2003, 

Windows Installer comes included. This program will not run on a Macintosh 

computer.  
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The Pocket PC device with one of the following operating systems installed: Pocket 

PC 2003/SE or Windows Mobile 5.0. A 400 MHz processor at least (624MHz 

altamente recomendable). To have the Socioeconomic Survey Form operating on the 

Pocket, Microsoft .Net Compact Framework 2.0 Redistributable (or greater) must be 

installed. 

The SSF only takes up 1 MB of disc space. 

1.3 Glossary of terms used 

Check boxes - Small square boxes to the right of a choice. When checked (an "X" 

appears in the box) the choice is active (signals: yes). When not checked the choice 

is not active (signals: no). 

Combo box - Text list that allows you to select an item from a list. This control 

displays the current selection (if available) in its input field. Clicking on the down 

arrow (drop down menu) will show the available text entries. Meaningful use of a 

Combo Box could be a list of states or countries, for example. 

Capture controls – These are the controls that accept text responses/information 

entries through the keyboard and/or mouse strokes to select or change an option. 

Strictly speaking, they are all the SSF controls save for labelCtrl. 

Display controls - This refers to the static text shown on screen that cannot be 

changed when in Interview mode. The controls that can display static text on screen 

in SSF are labelCtrl, checkCtrl and tableCtrl. 

Key field (primary key) - The unique identifier for a row in a database table. 

Label - Any descriptive text used for a description of another control or a form page. 

Option (or radio) buttons - A group of small circles inside a box. Only one of the 

buttons in the box can be active at a time. The advantage of this control is a faster 

selection. A disadvantage is the dramatically increased use of space on the form 

because all the options are displayed on the form. 

PC - Acronym for Personal Computer. It is a term used to describe a class of 

personal computers based on Intel's 486 microprocessor and designed to be used by 

one person at a time. 
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PDA or Pocket PC - Short for Personal Digital Assistant, a handheld device that 

uses a stylus rather than a keyboard for input. PDAs today are available in either a 

stylus and/or keyboard version. PDAs are also called Pocket PCs.  

Questionnaire - The actual survey form that contains your questions. 

Relational database - A database where data are stored in more than one table, 

each one containing different types of data. Any data element (values) can be found 

in a relation by knowing the name of the table, the attribute (column) name, and the 

value of the primary key.  

Table - A collection of data elements (values) that is organized using a model with 

horizontal rows and vertical columns 

Template - Complete set of elements for particular types of questions from the 

questionnaires. The template also includes a set of logical rules. 

Text box - A box surrounding text where text can be typed. Some programs allow 

you to set the box so it accepts a certain number of digits. For example, the box 

could be set to accept five digits to correspond with postal codes from a specific 

area. 

Value - A number or a numeric code for an answer to a question.  For example, if 

the question is "Are you married?" a value of 0 might represent "No" and a value of 

1 might represent "Yes."   

XML attribute - Attributes are used to specify additional information about the 

element. It may help to think of attributes as a means of specializing generic 

elements to fit your needs. An attribute for an element appears within the opening 

tag. For example, in the tag <form title='General information'>, title is an attribute, 

and General information is its value. 

XML Tag - A piece of text that describes a unit of data, or element in XML. The tag 

is distinguishable as markup because it is surrounded by angle brackets (< and >) as 

for example, <category>Sharecropped</category>  

XML element - An XML tag together with its contents. A unit of XML data, delimited 

by tags. 
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2. Installation guide 

Installing the SSF is very simple. If the required programs are already installed on 

your computer for the correct installation of SSF, then simply run the Socioeconomic 

Survey Form PC.msi file and/or Socioeconomic Survey Form Pocket.msi file and 

follow the instructions. 

Following is shown the installation for PC and for PDA, separately. 

2.1. Installation of the socioeconomic survey form for 

PC 

The installation program comes in a file called Socioeconomic Survey Form PC.msi. 

Locate the file and select it using Windows Explorer. Double left-click or right-click to 

open the contextual menu, and select Install. 

 

Note: As pointed out in the requirements, if your computer does not have the 

specified version of Microsoft .Net Framework, when you run the SSF installation the 

program will display the following informative window: 
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Install .Net Framework in whatever manner is most convenient for you and then 

return to the installation process. 

The installation sequence will now begin. As you can see, the welcome screen should 

appear next. 

 

Click on Next> and a 

dialogue box will open up 

with program-related 

information. 

 

 

Click on Next> to see the 

type of license included in the 

software. 
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Accept the licence 

agreement to continue. 

Click on I agree and then 

Next>. Next you will be 

shown a destination file for 

the installation. 

 

 

You can either accept the 

suggested file or select a 

different route for the 

program installation. Click 

on Next> to continue. 
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Final set-up screen. You will 

no longer be asked 

questions so this is your 

last chance to cancel the 

process if need be. Click on 

Next> to confirm and start 

the installation. You will be 

shown the progress of the 

installation. 

 

 

Finally the last screen will 

appear, confirming that 

the installation is almost 

complete. 
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End of the process. 

Click on Close to close 

the window and exit 

the application. 

2.2 Installation of socioeconomic survey form for 

Pocket 

The SSF version 1.0 has been tested in Windows Mobile 5.0, Windows Mobile 2003 

SE operating system, and Pocket PC 2003, with a screen size of 240 x 320 pixels and 

in portrait mode. It has not been tested on Pocket PC with previous operating 

systems such as Windows Mobile 2002. As well, it has not been tested on Windows 

Mobile 6.0 or higher.  

The procedure shown below operates on Windows Mobile 2003 Second Edition 

devices. However, the process should be similar for Pocket PC 2003 and for Windows 

Mobile 5. 

To install SSF in your PDA, you need to: 

- Synchronize the PDA with your PC, and 

- Install SSF in the PDA from your PC  

To synchronize the PDA with Windows PC use ActiveSync. This can be done by 

placing the Pocket on its base (desktop cradle), turning it on, and connecting the 

desktop cradle to your PC by attaching the USB cable to the USB port on both your 
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PDA and your PC. Then connect one end of the AC adapter to the cradle and the 

other end to an electrical outlet.. The following screen is displayed: 

 

You may select any 

option, but the easiest 

option is Guest 

partnership. Click on 

Next >, since you do not 

need to synchronize data 

for installing the 

program. 

 

Afterwards, the complete connection screen is displayed. 

 

 

Once plugged-in, locate and select 

the Socioeconomic Survey Form 

Pocket.msi file; for example, with 

Windows Explorer. To start 

installation immediately, double-

click on this file from its current 

location. The installation will start 

automatically, and a Setup Wizard 

will guide you through the process. 

 

The welcome screen is displayed first. 
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Then click on Next >. 

The following screen pops up. 

 

Enter the path of the folder 

where you want to install the 

program or accept the suggested 

path. Then click Next > to 

continue. 

Subsequently, the following screen is displayed. 
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Here the screen requires you 

to confirm the settings 

selected for the installation. 

This is your last chance to 

review and modify the changes 

entered. Click Next > to start 

installation. 

The following screen is shown. 

 

The program will start to install 

the files on your hard disc. It 

will show if installation was 

successful or if there were 

problems.  

A link to your Pocket PC will then be established. The Setup Wizard will then ask you 

if you want to install the program in the default directory. 

 

If you do not have a memory storage card or if you want to install the program on 

the main memory of your PDA, select “Yes” and the program will be installed in your 

Pocket PC. 
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If you have CompactFlash cards or Secure Digital Memory and you want to install the 

program in one of these, select “No” and a menu will ask you for the destination. 

 

 

Select the destination you prefer, and then click on OK to finish the installation 

process. 

Please note that when a program is installed on the memory storage card, removing 

it makes the program unavailable when trying to open it. In this case the Pocket will 

show an error message “Cannot find ‘Socioeconomic Survey Form’ (or one of its 

components). Make sure the path and filename are correct and all the required 

libraries are available.” If you want to work on the program and it is installed in the 

memory storage card, make sure the card is properly inserted in the PDA. 
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3. Socioeconomic survey form for PC 

Once the program is installed you can download it using Start > All Programs > 

Socioeconomic Survey > Socioeconomic Survey Form. 

 

But you can also run the program with Windows Explorer by opening a template file, 

double clicking on the template file or using the contextual menu, as shown below: 

 

Regardless of how you open the program, the following screen will appear displaying 

the main menu.  

 

The program should then display a 

menu at the top with four options: 

Template, Survey, Window, and About. 
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3.1 Description of the main menu 

Menú Template 

 

The Template menu displays the following options: 

New Creates a small template that is fully functional and includes all the capture 

controls. 

Open Opens an existing template (*.ssf) and enables the Survey menu for 

capturing data or modifying the design of the survey. 

Close Closes the current template. If changes were made to the template after 

opening it, the application will ask you if you wish to save them. 

Exit Shuts down the application (SSF) after asking you to save the changes made. 

Survey Menu 

 

The Survey menu only has the following two options: 

Interview This option is enabled once the existing template is opened or once a 

new one has ben created and saved to the disc. It displays the 

template on the screen so that new data can be input, modified or 

deleted from the database.  
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Design Allows the user to continue working on a previously designed template 

by clicking on the menu option Template > Open. The user can also 

open a new template to be designed by clicking on Template > New. 

Window Menu 

 

The Window menu has the following options: 

Cascade If you are working with two windows (Interview and Design), this 

arranges them into a cascade shape. 

Horizontal This sets up the two windows. If they are open they will tile 

horizontally. 

Vertical This sets up the two windows. If they are open they will tile vertically. 

The following show the different set-ups: 

Cascade 
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Horizontal 

 

Vertical 

 

Additionally, if both the Interview and Design windows are open, you can move from 

one to the other by choosing the name at the end of the Window menu, as shown 

below: 
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About Menu 

This displays a simple window with the name and version of the program, copyright, 

and the name of the developer of the application. 

 

 

3.2 The application in Design mode 

Access this option is by going through the main Survey menu and then selecting 

Design. 

 

Notice that the Design menu option is only 

available if you have previously opened a 

template or you are starting a new one. 

The first time you load a template in the Design window you will see the following: 
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This window is divided into two panels: 

Left panel In order to hierarchically represent the elements of the template a 

tree-shaped structure (list of controls) is shown in the upper part 

of this panel. The lower part of the panel shows the properties (list 

of properties). 

Right panel This serves to display the shape and position of all the controls of a 

specific form, such as labels and boxes of text. We refer to this 

panel as view of controls. 

The area available for these two panels can be modified to suit the user. The SSF has 

a vertical bar that divides these panels which can be moved by selecting it with the 

mouse and then moving it left or right to modify the width of the panel in question. 
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3.2.1 Description of the Main menu 

When you open a template and you are in Design mode, the main menu is modified 

and displays the following new elements: 

Template Menu 

 

This sets up the following new options: 

Save Saves the template to a disc file in XML format. If the template is new, 

the application asks for a file name. 

Save As … Allows you to save the template under a different name or in a 

different place, or both. By changing the file name and/or path, the 

new template becomes the current one. 
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Edit Menu 

 

This menu affects the controls that appear in the right side panel (view of controls) 

in the Design window. 

The only options available are: 

Copy Copies the controls selected in the controls view. You can use cut and 

paste to transfer data from one form to another. The contents of the copy 

can be replaced by another Copy operation. 

Paste Inserts the previously copied controls into middle of the current form. The 

inserted controls inherit all the properties of the copy, except for name 

and position. The application automatically assigns a unique name 

according to the type of control, for example, checkCtrl1, comboCtrl5, etc. 

Delete Deletes all the controls currently selected. These controls are not copied in 

the memory, so the operation is irreversible. 

3.2.2 Description of the upper left panel (list of controls) 

The template is hierarchically represented in the shape of a tree. Using the mouse or 

the keyboard you can navigate through the forms and their respective controls. 

Using the Keyboard 

Use the following combinations of keys to navigate between the nodes of the tree. 

 To open and close a node, click on the right (or +) and left (or -) arrows. 

 To move forward or back a level in the tree node structure, click on the right and 

left arrows. 

 To move to the following open node, click on the down arrow. 
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 To move to the previous open node, click on the up arrow. 

 To move to the start or the end of the tree, click on Home or End. 

Using the mouse 

 Click on the name of the node to select it. 

 Clic on + or – to open or close the node. 

 Double click on the name of the node to open or close the node. 

The basic structure of the list of controls is shown as follows: 

 

Here you will always see an <XML> node root, the <title of the survey> (Survey 

demo in this example), the node <forms>, and the different <forms> coming out 

of the node forms. 

 

To view the content of 

the forms, just open 

the desired form and 

the view of controls 

panel displays the 

controls. 
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You can also view the 

content of the tables by 

opening this node in 

the list of controls 

panel. 

 

 

All the controls in the 

left and right panel are 

hidden when the 

current form is closed, 

as shown in the figure. 

As you can see, an open node icon (−) indicates that the associated nodes are 

visible, and a closed node icon (+) shows they are hidden. 

To hide all the nodes, click on the minus sign (−) to the left of the <XML> node root. 

 

The nodes contract, visually indicating that the associated nodes are hidden. 

Control Tab Order 

The control tab order indicates the order of the capture controls, that is, the next 

data entry control that you see when you hit the Tab key. 

The following figure shows the order of the controls under General:  
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If you are entering data in the idNumber control, and you hit the Tab key, the 

cursor immediately jumps to the fullName capture control, as is specified in the left 

panel, list of controls. The order you see in the left panel is not necessarily the same 

as the one in the right panel, view of controls. 

 

You can change the 

order of the nodes. On 

the left panel, click on 

the node you wish to 

move. 

 

 

Drag the selected node 

to a new location (within 

the same form) and 

drop. 
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Notice that in the left panel, the Id number label now appears after the idNumber 

capture control, and that the right panel showed no change whatsoever. 

You can also move the form type by selecting it and moving it to where you want it, 

as in the previous example. 

This version of SSF only permits changing the order of a node one at a time. It is not 

possible to select a group of nodes and move them all to a new position in one move. 

Description of the node icon 

Following are described the different icons that show the nodes to the left. 

 Root The main root of the node. It is only a representation of the XML 

structure. 

 Application This node corresponds to the application properties, such as the 

title (displayed as the name of the node), automatic presentation 

of the keyboard (for the Pocket PC), the unique key identifier for 

record management, and lastly the name of the main table in the 

database. 

 Forms The node Forms is a basic node which displays the different forms 

the user adds to his/her questionnaire. There should be at least 

one form per questionnaire. 

 Form This shows the title of the current form. 

The controls shown below belong to the current form and are the ones that give 

shape to it (capture and display). There should be at least one control per form. 

 labelCtrl Control that only serves to put labels or titles on the form. It usually 

comes before the entry control to describe what is being captured. 

 alpCtrl This allows the user to introduce alphanumeric text. It can limit the 

number of characters to be entered. 
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 numCtrl This allows the user to introduce numeric text only. It can control 

the range of values, and even the number of digits to capture. For 

example, to introduce the postal code it can be limited to five digits. 

 dateCtrl This control allows the user to introduce a date easily and correctly. 

 checkCtrl Control used for Yes/No (true/false) questions. A check mark means 

Yes (value of 1) and no check mark means No (value of 0). Use 

checkCtrl for very simple questions. If you wish, you can assign a 

default value (0 or 1) that is used when a new record is generated 

in the Interview mode. 

 comboCtrl Allows you to choose an option from a list of alternatives that drops 

down. You can put a default option that is selected automatically 

when a new record is added. 

 radioCtrl This control is used to select an element within a list of options. This 

control is an alternative to comboCtrl in the manner of selecting an 

option within a list of multiple options. All the options are presented 

on the screen so that the selection can be made more quickly; the 

disadvantage is that it occupies more space in the form. 

 tableCtrl tableCtrl is designed like a button so that the user can introduce a 

table in a capture form. Usually tables are identified in the 

questionnaire when there is a two-dimensional arrangement with N 

columns and N rows, such as, for example, capture by age, gender 

and schooling of all the members of a family. 

Contextual form menu 

The following describe the different menus that appear in the left panel, list of 

controls. 

There are only two menus available in the panel and these are form and control. 
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Form menu 

 

Description of the menu 

a. Insert form below 

Insert a new form right under the selected form. 

 

 

The program automatically assigns a title to the form and adds a label type control 

(labelCtrl). You can change these titles later on for your convenience. 

  

b. Delete 

Permanently deletes the selected form. The deletion also includes all the controls 

associated with this form. 
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Before eliminating the form, the system will wait for you to confirm your choice. 

 

c. Nudge up 

Moves the node up one level above the one before it. You can also do this by 

selecting the node with the mouse and dragging and dropping it where you want it. 

 

 

 

d. Nudge down 

Moves the node down one level below the one that follows. You can also use the 

mouse to move the node down by selecting it, dragging it down and dropping it 

where you want it. 
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Contextual control menu 

This contextual menu only appears when the node is of the control type. When you 

right-click on one of these nodes, the following appears: 

 

This menu has the following options: 

Insert control below Inserts a control under the selected node. 

Delete Eliminates the selected node in the left panel list of controls 

(also the right panel), with no prior confirmation. 

Nudge Up Moves the node up one level. If the node currently occupies 

the highest position, the operation does nothing. 

Nudge Down Moves the node down one level. If the node currently sits in 

the lowest rung, the procedure does nothing. 
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Insert control below menu 

As has been pointed out, this option inserts a node of the control type under the 

selected node. When a control is inserted, it appears as a node in the upper left 

panel (list of controls), displaying some of the properties in the lower left panel (list 

of properties), but it also occupies a place in the right panel (view of controls). 

The inserted control will be occupying a position slightly lower than and to the right 

of the node preceding it, to prevent the new inserted control from covering some 

other existing one. 

 

The controls can be inserted using the following: 

labelCtrl Adds a static label. Assigns the name label# by default. This name is 

only used internally by the application, as this type of control does not 

generate a field in the database. 

alpCtrl Adds a control for capturing alphanumeric text. Generates the name alp# 

and by default limits it to a maximum length of 255 characters. 

numCtrl Adds a control that limits the capture to numeric values only. 

Automatically creates the name num#. 

checkCtrl Adds a verification box. Assigns it the name check#. 

radioCtrl Adds a radio button with two elements (radio#_1 and radio#_2) as 

categories. By default, assigns the name control radio#. 

comboCtrl Adds a drop-down list with two elements (Option1 and Option2) as 

categories. Assigns the name combo#. 

dateCtrl Adds a control of the date type in a short form set up by its own system. 

The date format is set up by the system (System Settings) in the PC and 

in the Pocket. Creates the name date#. 

tableCtrl A button is added as a link to the table. A text label for the table is 

generated by default. Notice that the table created is empty as at it does 

yet not include capture controls that can form part of the database. The 
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name of the control that is automatically assigned (and which is also the 

name of the table in the database) is table#. 

3.2.3 Description of the lower left panel (list of properties) 

The list of properties panel displays the properties set up to the different elements of 

the template. The content depends on the type of control selected; for example, if 

you are working with the form node, the panel displays all the properties associated 

with this node. 

When you open a template and display it in the Design mode, the list of properties is 

displayed, located in the lower left panel of the program. 

 

As you can see, the list of properties is grouped into five tabs, as follows: 

Application Displays the general properties of the application such as the title of 

the survey and the name of the database, among others. 

Form Displays the title of the selected form. 

Control Displays the properties inherent in the selected control, such the type 

and name of the control, the position it occupies on the screen within 

the capture form, etc. 

Categories Displays the elements of the categories that are part of the controls 

comboCtrl and radioCtrl.  
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Script Displays the scripts associated with the selected control. Scripts are 

events that occur in Interview mode, after entering a value or 

selecting an option in a capture control. 

To view the properties of a node, simply select it in the upper left panel (or in the 

right panel view of controls), and you will then see the associated properties of this 

particular control in the lower left panel. 

General warning 

In general, the changes you make to the design of the template that have to do with 

changes in the database, such as the name of the main table in the database, 

changing the name of a data entry control, adding a new capture control, eliminating 

the categories of a radioCtrl or comboCtrl type control, are not compatible in 

Interview mode when the database contains records (where you have introduced 

data). It is not possible to automatically make the changes in the design of a 

template compatible when the template is already being used in production. Change 

the modified template to a new working directory, or delete the XML files it 

generates, or simply do not add records in the Interview mode when the template is 

constantly being changed. 

In general, changes to the template such as add/modify/delete static text labels 

(labelCtrl), changes to the control properties such as position, default value, range, 

scripts, etc. DO NOT modify the database. These changes can be made even when 

the database is in production. 

Application 

This tab is the first you see when you first open the template. 

 

The template has the following options: 
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a. Survey title 

This is the title that is shown in the title bar of the window when in Interview mode. 

 

b. Turn keyboard on/off automatically (Pocket PC) 

When the box is checked, the keyboard of the Pocket appears automatically when 

you position yourself on a control that requires text entry (such as alpCtrl and 

numCtrl). It hides automatically when the keyboard is not usually required (for 

example, checkCtrl or comboCtrl). This property does not apply in PC environments. 

  

c. ID 

ID is used as a key field in the database. ID keys are only candidates for controls of 

the numCtrl and alpCtrl type. When one of these controls is added to the template, it 

is automatically added to the drop-down list following the Id label for eligibility. 
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d. Database name 

The application allows you to set the name of the main table in the database, 

assigning the name principal by default. The principal table refers to the name of the 

table that stores all the data of the different forms that are not part of a secondary 

table, that is, all the data that does not come from a control of the tableCtrl type. 

The data is stored in XML format as shown below: 

<?xml version="1.0" encoding="utf-8"?> 
<!--...XML-Datafile generated by Socioeconomic Survey Design ...--> 
<dataroot> 
  <principal> 
    <record> 
      <idNumber>1</idNumber> 
      <fullName>Mary Ross</fullName> 
      <employee>1</employee> 
      <birth>10/24/1980</birth> 
      <marital>0</marital> 
      <children>0</children> 
    </record> 
    <record> 
      <idNumber>2</idNumber> 
      <fullName>John Carpenter</fullName> 
      <employee>0</employee> 
      <birth>8/21/1985</birth> 
      <marital>5</marital> 
      <children> 
      </children> 
    </record> 
  </principal> 
</dataroot> 
 

Form 

This is the second tab of the list of properties panel. It displays the title of the form if 

one has been selected. 
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The name of the form is used to group the different sections of a questionnaire in a 

logical manner. In Interview mode, the capture screen displays in different tabs in 

accordance with the number of forms in the template. Under this concept, you 

cannot have two forms with the same name. 

 

In order to manage the forms efficiently, use a short descriptive name. When 

creating a form, the program assigns a name by default, but it also allows you to 

change it to one that is more descriptive, depending on the content of the form itself. 

Although the capture is divided into different capture sections (tabs), physically the 

data is stored in one table, specified in the Database name property. The name of 

the form is not used to create a new table in the database.   

Control 

The control tab shows the properties associated with a control when the control is 

selected in the upper left panel list of controls. 
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Some properties cannot be 

altered and that is why they 

appear in grey (disabled). The 

properties are disabled because 

they do not apply to this control. 

The user cannot modify the 

position control either as this has 

to be done in the control view 

with the mouse..  

Following is a list of the properties: 

a) Property of Type control  

Displays the type of control selected. As you know, the types of controls that exist 

are: labelCtrl, alpCtrl, numCtrl, checkCtrl, radioCtrl, comboCtrl, dateCtrl, and 

tableCtrl. This list is read-only, it cannot be modified. The controls are added for the 

first time in the left panel list of controls and can be replicated in the right panel view 

of controls using the copy/paste command. 

b) Property of Name control  

Name of the control. When this control is created, it is automatically assigned a 

unique name, though you may change it to a more descriptive one. Consider short 

names for greater portability, because the data analysis will probably be done using 

a statistic program and this may limit the size of the name. Consult the statistical 

program specifications for the creation of variable names. 
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The name can be modified in the textbox 

Name in this tab, and also in the name of 

the node. 

This name must be unique and must not be used by any other control. When 

assigning a name the system checks to see that it is not repeated, and if it is it sends 

out a warning message. 

 

All controls have a name, save for labelCtrl, though internally it is assigned a 

temporary name because a reference is needed for locating it in the different panels 

in which it appears. Do not be concerned about the name assigned to labelCtrl, as it 

is not part of the template or the database. The next time the template is opened it 

may take a name that is different from the one previously assigned. 

c) Property of Question text control  

This property only applies to the controls of the labelCtrl, checkCtrl, and tableCtrl 

type. Given the nature of this type of control, a window may on the screen displaying 

a descriptive text label. 

d) Property of Caption text control  

These are long descriptive names that may replace the name of the control. Useful 

mainly when assigning short names such as, for example, var1, var2, etc. This 

property is used exclusively for exporting purposes, as some statistical programs 

incorporate this feature for data management. Consult the text length specifications 

depeding on the program used to import the data. 
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This property does not apply to the labelCtrl and tableCtrl controls, as they are not 

part of the database. 

e) Property of Default control  

Value assigned by default when entering a new record in Interview mode. The 

default value depends on the type of control, so, for example, it might be a number 

for numCtrl and true/false for checkCtrl. 

When the control is of the alpCtrl and numCtrl type, the value is directly introduced 

into the textbox Default, but when it is of the checkCtrl, radioCtrl, and comboCtrl 

type, the system presents you with the valid options available according to the type 

of control selected. 

 

In this example, because the control 

selected is of type checkCtrl, the user 

can only select two options. 

This property does not apply to controls of the labelCtrl, dateCtrl, and tableCtrl 

types. 

f) Property of Position control  

These are the coordinates of the position the control occupies in the capture form. A 

read-only property that can only be modified in the right panel view of controls. 

For example, the position 80,40,100,24 means: 
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g) Property of Max length control 

This refers to the number of characters that can be introduced in Interview mode. By 

default, when an alpCtrl is created it is assigned a value of 255, which is the 

maximum allowed. 

Applies only to the controls of the alpCtrl and numCtrl type. 

h) Property of Range control  

List of numeric values allowed in data entry. The format of the Range property is as 

follows: 

initialValue..endValue) 

The values included are within a range of initial and end values. More than one range 

can be specified, separated by commas. For example, 1..10,50..60 means that the 

system only allows values to be entered that run from 1 to 10 and from 50 to 60, 

inclusive. 

Use the … key button located to the right of the property to add and/or delete the 

range of values. 

 

Pressing this button key will display the following dialogue box: 

 

Fill out the Minimum and Maximum fields here with digits, and then press --> to 

add it to the range list, or select an item from the range list and then press <-- to 
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delete it. You can accept the changes introduced or cancel and go back to the list of 

properties panel. 

 

Begin by incorporating the list of 

previous ranges and saving it to 

the template file. When you are in 

Interview mode, the system will 

display a warning message if you 

try to introduce a value outside 

this range. 

Applies only to controls of the numCtrl type. 

Categories 

The Categories tab refers to the different static text entries that the controls of the 

comboCtrl and radioCtrl type can have. When selecting this type of control in the list 

of controls panel, the Categories tab in the list of properties panel displays the text 

entries for the control selected. 
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To add, delete, or change the entries of a comboCtrl or radioCtrl control, click on the 

button located in the lower part of the Categories tab. The dialog box Category will 

appear. 

 

Here you can change the 

list of entries as you see 

fit. Click on <New> to 

add a new entry to the 

list. 
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Introduce the new entry into the text box 

called Label and select <Add> to add it. 

 

 

Notice that the list of entries has been 

updated, and notice that the numeric 

value of 6 is automatically added, a code 

that records in the database when you 

select this label in Interview mode. 

  

To delete an entry, simply highlight it 

and click on <Remove>. 
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The order of the list can be changed by 

selecting the entry with the mouse, and 

dragging and dropping it to the preferred 

position. In this figure, the category 5 = 

Never married and no kids was moved to 

the position 0. 

Note that all the entries change their code depending on the position they occupy in 

the list. Remember that this value is stored in the database, and if you change the 

order the value recorded in the database may no longer correspond to the previous 

label. 

Save all changes by clicking on <Accept the categories> or cancel them by clicking 

on <Cancel>. 

 

Once you have defined the 

categories the default entry 

can be selected in the Control 

tab, as is shown in the figure. 

 

 

If you specify a default value, in Interview mode the system will automatically select 

it every time a new record is added. 
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Script 

Scripts are events that occur automatically when selecting or introducting a value in 

a capture control. For the time being, the controls that support scripts are checkCtrl, 

radioCtrl, and comboCtrl. When selecting one of these controls, the 

<Add/Remove/Change…> button from the Script tab is enabled. 

 

When clicking on <Add/Remove/Change…>, the following window immediately 

appears: 
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Description of the window Script 

Type 

Allows you to select one of the three types of scripts supported: skipTo, message, 

and disabled. 

 

Condition 

This is the condition that needs to be met for the event to be activated. The type of 

condition depends on the control selected. In this example, we have selected 

checkCtrl, so the valid options to choose from for this condition would be True or 

False. 
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target 

This is the manifestation of the event. The target attribute depends on the type of 

event selected. For example, for the skipTo and disabled types, we have to add a 

control from the available list; for a type of event such as message, we have to write 

in a text message by hand. When the type of event is disabled, more than one 

control can be added. 

 

If you have added a control and wish to delete it from the list, simply select it again 

and click on <Remove> as shown below. 

 

New 

This is the first button you click when adding an event. It enables the necessary 

attributes to create an event of the type, condition, and target desired. Once all the 

requirements are met, click this button again (now with the label Add) to add the 

event desired. 

 

Once the event is created, you can modify or delete it. 
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Change 

First select the event to modify, make the changes necessary in the type, condition, 

and target attributes, then click on <Change> to reflect the changes made. 

Remove 

First select the event to delete, then click on <Remove> to remove it from the list of 

events. 

Change the order of the list of events 

The list of events comes in the order in which it was created; however, it can be 

modified by selecting the event and holding the right side of the mouse down while 

dragging and dropping it into the desired position. 

Accept the Scripts 

Closes the Scripts window by first saving the changes made to the list of events. 

Cancel 

Closes the Scripts window by cancelling any changes made to the list of events. 

Keeps the original list. 

3.2.4 Description of the right panel (view of controls) 

The right panel view of controls is a visual surface that allows communication with 

the user by means of controls. A control is a user interface element that displays 

information or accepts data entries. 

In the left panel list of controls you can easily create the controls on the form, and 

once created, select them in the right panel view of controls and drag and drop them 

where you want them. Basically, it first draws the control in the form, modifies the 

width, height, and position it occupies on the screen, and then modifies its properties 

in the list of properties panel. 

There are two ways to add a control to the form. One is by adding the control from 

the list of controls panel using the Insert control below menu and the second is 

through the options Copy/Paste from the main menu. 
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Step 1.  Create the control if none has been created yet of this type. 

 

 

 

Step 2. Modify its size and position 
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Step 3. Define its properties 

 

Step 4. If you need to add another control of the same type, and they more or less 

share the same properties, you might like to Copy/Paste the same control. So select 

the controls you want and click on Copy. 
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Step 5. Once the control is copied, click on Paste. It will appear in the middle of the 

screen so you will need to select it and move it to where you want it. 

 

 

Every time a control is pasted in the form, it will appear in the middle of the form 

aligned to the left; if you repeat the operation try to move the previously pasted 

control first, that way the second copy will not appear on top of the first. 

Note that you can select more than one control at a time, change the size and move 

it/them, delete, and even copy and paste. 

 

 

 51 



3.3 The application in Interview mode 

This section explains the final steps taken with the template: capturing and exporting 

data. 

 

To work in the Interview 

mode, first open a 

template and then click on 

the main Survey menu, 

then on Interview. The 

capture window appears. 

If the database is not 

empty, it looks like this. 

 

3.3.1 Description of the Interview window 

The following describe the different elements that make up the Interview window. 

a. New 

Clicking on <New> generates a blank record that later can be added to the database 

by clicking on <Save>, or cancel by clicking on <Cancel>. 

 

Note that the command 

<New> enables the <Save> 

and <Cancel> buttons. 
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b. Edit 

Once records have been introduced into the database you can review and make 

changes to the records that have been captured. Just place yourself in the record 

you wish to edit and click <Edit>. The following figure shows a date type field being 

edited. 

 

Once the necessary 

modifications have been 

made click on <Change> to 

reflect those changes or 

<Cancel> to abandon the 

changes made. 

 

c. Carry record… 

Occasionally, some records will have very similar data. Instead of introducing all the 

information it is more advantageous to copy it from the record that has already been 

captured and then make the respective changes. To do so place yourself in the 

record you wish to copy and then click on <Carry record…>. 

 

If the database you are 

working on has a key field, 

you will be asked for it 

before generating a new 

record. 

 

Notice whether the record includes tables; these should be copied, too. 
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d. Delete … 

Deletes the current record with prior permission from the user. 

 

e. Go to … 

Shows a dialogue box and waits for an entry by the user. You will be asked through 

the Id field if the database has this attribute, otherwise it will ask for the record 

number. 

 

 

To look for a record, type the Id 

number or record number into the 

textbox and click on <OK>. If the 

system finds the Id or the record 

number that has been typed in, 

the window closes and the record 

appears. 

 

f. Position 

Displays the words Record Position/Count where Position is the current position with 

regard to all the records and Count shows the total number of records contained in 

the database. 

g. Navigation bar 

The navigation controls will appear in the lower part of the Interview window.  
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Click as follows to: 

 Go to the first record 

 Go to a previous record  

 Go to the following record 

 Go to the last record 

3.3.2 Contextual menu for comboCtrl and radioCtrl 

When starting the capture, it becomes clear that there are questions that have no 

answers; these will appear as blank in the database and some database systems will 

consider them null. 

While capturing you can leave a blank value in the alpCtrl and numCtrl controls, and 

in the radioCtrl and comboCtrl controls record a blank value by simply not selecting 

an option. But what happens if you have selected an option and wish to remove it? 

The normal Windows controls do not allow for this, and so a contextual menu has 

been created for these types of controls that allow for this and more. 

Access the contextual menu by right-clicking on the radioCtrl and comboCtrl controls. 

Contextual menu comboCtrl 

On a comboCtrl, right-clicking on an option brings up the following menu: 

 

Notice that two options are displayed: 

a. No select 

This option appears if the comboCtrl already has an option selected. The option No 

Select allows you to leave comboCtrl without a selection. 
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b. Add new item… 

This option allows you to add a new option at the end of the list. 

 

Click on <Add> to add the new option 

at the end of the list or <Cancel> to 

cancel the changes and close the 

window. 

Remember that if you are adding a 

new option to the template and are 

capturing in more than one computer, 

you will also have to record this 

change in the other templates to 

ensure consistency among the data. 

 

Contextual menu radioCtrl 

To show the contextual menu of a radioCtrl, simply right-click on a selected option. 

 

The only menu option to appear is 

Uncheck, which means removing the 

selection check. 

 

3.3.3 Export menu 

The data captured is recorded in XML format, but can be converted to another 

format. To export, click on the Tools > Export… menu. 
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The name of the table to be 

exported will by default be the 

name of the file with a csv 

extension for CSV and xls for MS 

Excel. The exported files are 

stored in the same folder where 

the template was opened, which 

is also the one where the 

captured data is stored. 

If you repeat the export operation more than once, the existing files will be replaced 

without prior warning, except for the MX Excel type which will await user 

confirmation. 

 

Description of the Export window 

a. Tables 

Displays all the tables in the database. Select one or all the tables from the list you 

wish to export. 

b. Export file type 

Displays the different file formats you can export. To date there are only three, and 

these are: 

CSV 

Exports the data to a text file whose values are separated by commas. The first row 

is the name of the columns, and the values appear from the second row on. For 

example, the data shown below is from the principal.csv exported file: 
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'idNumber','fullName','employee','birth','marital','children' 

1,'Mary Ross',1,'10/24/1980',0,0 

2,'John Carpenter',0,'8/21/1985',5,4 

3,'Peter Smith',1,'12/17/1987',0,0 

This file format is the most popular and portable, and can be read by many text 

editors, database managers, and spreadsheets. 

SPSS Syntax 

Generates a SPSS command syntax file. Two files are exported using this option, one 

is the file separated by commas (.csv) and the other is the SPSS syntax file (.sps). 

For example, if you export the main table, it will generate the files principal.csv and 

principal.sps. The file principal.sps contains lines of text that look like this: 

GET DATA /TYPE = TXT 
 /FILE = 'principal.csv' 
 /DELCASE = LINE 
 /DELIMITERS = "," 
 /QUALIFIER = "'" 
 /ARRANGEMENT = DELIMITED 
 /FIRSTCASE = 2 
 /IMPORTCASE = ALL 
 /VARIABLES = idNumber F1.0 
 fullName A14 
 employee F1.0 
 birth A10 
 marital F1.0 
 children F1.0 
. 
 
VARIABLE LABELS idNumber 'Id number' 
 / fullName 'Full name' 
 / employee 'Is your spouse/partner employed' 
 / birth 'Date of birth' 
 / marital 'Marital status' 
 / children 'How many children do you have' 
. 
 
VALUE LABELS marital 0 'Married' 1 'Partnered' 2 'Widowed' 3 'Divorced' 
4 'Separated' 5 'Never married and no kids' 
 / children 0 '1-2 Children' 1 '3-4 Children' 2 '5-8 Children' 3 'More 
than 8 Children' 4 'None' 
. 
 
MISSING VALUE  marital (-1) 
children (-1) 
. 
 
FREQUENCIES VARIABLES = employee marital children. 
 
DESCRIPTIVES VARIABLES = idNumber. 
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If the SPSS program is already installed and you open the file principal.sps, and run 

all the commands contained in the file, the tab Data view in the SPSS Statistics Data 

Editor will look something like this: 

 

MS Excel 

If you wish to export the data to an Excel file, select this option. The file principal.xls 

in the Excel program will look like this: 

 

Versions prior to MS Excel 2007 allow you to work with up to 256 columns, but if the 

table to export contains more variables (or fields) than MS Excel can contain, SSF 

allows you to split the file into two or more, depending on your need. 
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Note: For the sake of 

convenience, we have 

only taken 255 columns 

leaving one column free 

for movements between 

columns. 

 

The program will add _1, 

_2, _3, and so on to the 

end of the file name, 

depending on the number 

of divided files. 

Important note: 

Exporting to MS Excel only works if your computer has Microsoft Excel and is 

compatible with Office XP (2002), 2003, and 2007. 

The program searches for Excel, and if not found it will show the following error 

message. 
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4. Socioeconomic Survey Form for Pocket 

Welcome to the SSF for Pocket. This section is designed for you to begin to work 

step-by-step, describing —as an exercise— many of the program’s operational 

features. The file used as an example, Survey Demo, was copied to your PDA unit 

when you installed the program. 

4.1 Loading the program 

  

Once the program 

has been installed, 

an access link is 

copied on Start > 

Programs > 

Socioeconomic 

Survey Form. Only 

by clicking on it will 

the application 

open. 
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4.2 Entering data 

 

When you run the application for the first 

time, a screen with general information 

about the SSF is displayed. 

To begin entering data or to view data 

already entered, you need to load a 

template that reads SSF and displays the 

controls on the screen. To open the entry 

form, click on the option from the Tools 

menu of SSF, and then select Load 

Template. 

 

 

This opens a dialog box with a list of 

templates created with the Socioeconomic 

Survey Form for PC. The list shows all *.ssf 

files in the Pocket PC. In the case shown 

here, there is only one file on the list: the 

one copied when the SSF was installed. To 

open a screen, click on the file name. 
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The main entry screen will appear, showing 

the design of the form, with the tabs and 

entry fields. 

 

 

To make it easier for the user, we divided 

the questionnaire into small sections. In 

this example, the questionnaire is divided 

into two sections, one called General and 

the other called Personal, shown in the 

Pocket in the shape of tabs. To move from 

one tab to another, simply click on it with 

the tip of the Pocket pen. 

Now the program is ready for you to enter new information or read the existing data. 

The first time a template is loaded, the database is empty. When there are no 

records, the screen appears as a new record which you are required to complete. In 

the case shown, you must fill in both the “General” and “Personal” information tabs. 

In addition to these entry fields enabled for the data editing, there are two buttons, 
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the <Save> button that works to record the entered data, and the <Cancel> button 

to cancel the editing of the modified record. 

When you load a screen with previously entered records, it will show the edit fields 

disabled; you can see the data but not modify it, unless you click on <New> to 

create a new record, or <Edit> to change the saved data shown on the screen. 

4.3 How to enter data into the pocket 

Entering data into a Pocket to capture a questionnaire will depend on the type of 

data to be recorded. 

 

To enter numbers and text, you can use 

the input panel keyboard or the integrated 

external keyboard if the Pocket has one. 

 

 

There are Yes/No questions in a box or a 

radio-button option list. To choose from a list 

or check a verifying box, simply tap on it with 

your stylus. 

 

 64 



 

There are multiple-choice questions that 

allow you to choose an option from a list. To 

open the option list, tab on the small control 

triangle (upper-right side) with the stylus and 

choose an option from the list. 

To continue the tutorial, complete the fields and click <Save>. 

 

The lower menu has options from the 

menu and record navigation controls. 

The menu <New> prepares the screen 

for the entry of a new record and the 

menu <Edit> allows you to modify the 

current record. 

 

To continue the tutorial, enter two new records, repeating this process twice: 

1. Click on <New> 

2. Enter information in the fields, and  

3. Click on <Save> to exit the edition mode, saving the data of the previously 

entered record. 

 

If you have followed the step-by-step 

tutorial, there should now be three records. 
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To navigate through records, click on < to 

move to a previous record, and on > to 

move one record forward. To move to the 

first and last records of the form, select 

<current record/total number of records> 

and click on the desired option, as shown 

in the figure. 

 

 

The Tools>Delete current record... option 

allows you to delete the current record, 

upon confirmation. Click from the Pocket 

on the <Tools> menu and then on <

current record...> 

Delete 

And the following confirmation screen appears. 

 

Click on <Yes> to confirm that you want to 

permanently delete the record, or on 

<No/Cancel> to cancel the operation. 
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5. Tutorial (Step-by-step) 

This tutorial is intended to take the user by the hand in building a template for 

capture, basically, creating forms with their respective editing controls, generating 

scripts, copying the template to the Pocket PC, capturing some records, exporting 

data and briefly working with SPSS and Excel. This tutorial gives step-by-step 

instructions for the actions and procedures necessary to get the job done properly. 

5.1 How to create forms for capture 

The forms are built in the PC using the Designer menu option and then the design is 

checked by running some tests using the Interview menu option. To get started, you 

shall use a hypothetical questionnaire where you will administer all the controls that 

exist in the program. 

For the following steps, presumably the SSF program is open. If the SSF is not yet 

installed, please consult chapters Installation guide and Socioeconomic survey form 

for PC, for further information. 

If the program has been installed but is not yet open, load it by clicking on Windows 

Start > All Programs > Socioeconomic Survey > Socioeconomic Survey Form. 

5.1.1 How to create a new template 

Once the program is loaded, click on the main Template > New menu. 

 

The new template created will appear next. Given that the template is new, the 

program will automatically put it in Design mode, the equivalent of clicking on 

Survey > Design in the main menu. 
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To help you build your own database, the new template contains two small forms for 

making changes in line with your needs. 
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Basically, if you were to see this new template on paper, it would look like this: 

 

SURVEY DEMO 

A. General Information 

Id number: ____________ 

Full name: ____________ 

Is your spouse/partner employed? ______ (Yes/No) 

B. Personal information 

Date of birth ____________ (mm/dd/yy) 

Marital status 

 (   ) Married (   ) Partnered 
 (   ) Widowed (   ) Divorced 
 (   ) Separated (   ) Never married and no kids 

How many children do you have 

(  ) 1-2 (  ) 3-4 (  ) 5-8 
(  ) More than 8 (  ) None 

Age and gender of the children 

     Age Gender (M/F) 
1   ______ __________ 
2   ______ __________ 
3   ______ __________ 
4   ______ __________ 
5   ______ __________ 
6   ______ __________ 
7   ______ __________ 

 

5.1.2 How to create a new form 

For the purposes of the tutorial we will be adding a new section to the previously 

shown questionnaire, for example, section C which contains the following data: 

C. Other information 

What is your favorite color? (Select only one) 

(  ) Blue  ( ) Black  ( ) Yellow  ( ) Green  ( ) Other 
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First we added the form by right-

clicking on the last forms node, in this 

case the node Personal.  

In the contextual menu, we click on 

the option Insert form below and the 

newly created form appears 

immediately. 

 

 

The new form is called Form -12 by 

default, but in our questionnaire it is 

called C. Other information. 

 

 

To change the name of the form you click on the 

same node. And when the node is in editing mode 

you type in the new name and then <Enter> to 

finish the editing. 

 

 

Notice that the new title of the form 

also appears in the list of properties 

panel, where you could of course 

have changed the title of the new 

form. 
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5.1.3 How to add capture controls 

Our new form entitled C. Other information contains only one control of the labelCtrl 

type, which was automatically added when the new form was generated. 

 

A form is an area on the screen where the controls can be put. As we have seen in 

our new section of the questionnaire, we need two controls, one of the labelCtrl type 

and the other one that we are going to design of the comboCtrl type. 

 

So we are going to modify the title 

of the only labelCtrl we have in our 

new form by editing the Question 

text property in the Control tab in 

the list of properties panel. 

 

We need to create another labelCtrl to assign it the title “What is your favorite 

color?.” One easy way to do this is to copy/paste from the same control; to do so be 
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sure you have selected this control in the view of controls panel and click on Edit > 

Copy in the main menu. 

 

Once the selected control has been copied, click on Edit > Paste and the control will 

appear in the middle of the right panel, aligned to the left. 

 

Next, change the title and move the control under the first one. To change the title 

of the control, simply edit it in the Question text property or directly on the node. To 

move the control, select it with the mouse in the view of controls panel and, keeping 

the left mouse button pressed, drag and drop it into the desired position. 
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Now, according to our new section of the questionnaire, we need to create one more 

control. Place the cursor on the last control (node) created in the left panel list of 

controls and right-click. Select Insert control below > comboCtrl. 

 

You will note that the specified control will be generated and will appear under the 

previously selected control. 

 

In the right panel, move the control to a better position and change the following 

properties in the Control tab of the list of properties panel. 
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Notice that we have only changed 

the properties Name and Caption 

text. The property Position is read-

only and its coordinates reflect the 

position the control occupies in the 

right panel view of controls. 

 

 

Now we have to add the categories 

to the control comboCtrl. To do 

this, while selecting this control, 

click on <Add/Remove/Change…> 

located in the Categories tab of the 

list of properties panel. 

The window Category appears. 
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Notice that two categories were automatically added. We need a total of five 

categories (Blue, Black, Yellow, Green, Other), so we simply edit the two existing 

categories and add three new ones. 

 

To change the name of the first category, 

click on 0=Option1 from the list and 

change the text Option1 to the word Blue 

in the textbox Label. 

Next click on <Change> to make the change. 

 

Do the same for the second category on the list. Change the label Option2 to Black. 

  

Now add the three following new categories by clicking on <New>, typing the new 

category in the textbox Label and clicking on <Add> to add it to the list. Repeat the 

procedure for each new category. 
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So far we have entered all the options. Looking at the list, we can see the value 0 

corresponds better to the option Other. To make this change, simply select option 4 

= Other and using the mouse, drag and drop it into the highest position, as shown 

below. 

 

Once all the comboCtrl options have been entered, click on <Accept the categories> 

to accept the entry and return to the list of properties window. 

 

If you wish, you can give 

comboCtrl an initialization value so 

that it appears selected every time 

you capture a new record. In the 

Control tab click on the drop-down 

list located to the right of the 

property Default and select the 

initialization value. 

 

Let’s also take into account that the idNumber control is linked to the folio or number 

of the questionnaire, and let’s say you were assigned 20 questionnaires to capture, 1 
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to 10 and 50 to 60. You can create some validations controls such as restricting the 

total number of digits to capture and only permitting values in the assigned range. In 

the left panel list of controls, open the General form and select the idNumber node. 

 

In the Control tab of the list of 

properties, type in the value 2 in 

the property Max length. 

To introduce the range of valid 

values, click on <…> located to 

the right of the property Range. 

The following window will appear. 

 

In the window Range, simply 

introduce the value 1 in 

Minimum and 10 in Maximum, 

and click on --> to add the 

range to the list. 

 

 

Repeat the same procedure for 

values 50 and 60. 

Click on <Accept the range> to 

save the changes and return to 

the main window. 
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Notice that the list was assigned 

to the property Range. 

5.1.4 How to generate scripts 

The SSF program allows you to administer certain types of scripts, for example, for 

data capturing, if the marital status of the person surveyed is “Never married and no 

kids” you disable the question “How many children do you have?”. To do this, make 

sure to select the marital control and open the Script tab in the list of properties 

window. 
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To add a new script, click on <Add/Remove/Change…>. The following window is 

displayed. 
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Firstly, to build the script 

click on <New>. Notice this 

enables the capture controls 

Type, Condition, and Target. 

Select Disabled from the Type list. 

  

Next, from the Condition list select the option “Single, never married”. Note that the 

list that drops down corresponds to the options according to the control that was 

selected. 

 

In the Target list, select the option children. 

 

 80 



Now the new script is built, click on <Add> to add it to the list. 

 

And since we are only interested in one script, click on <Accept the Scripts> to 

return to the main window. 

 

Note that the script has been 

added to the exitScript list. 

 

5.1.5 How to save the template 

Once the template is built with all its forms, controls, and properties, save the work 

in a disc file by clicking on Template > Save in the main menu, and select or create 

the folder where you wish to save the template. Next, type in the new file name and 

click on <Save> to save it. 
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5.2 How to capture records in the PC 

Once the template has been built, proceed to record some data in the PC. Having 

opened the template Survey demo.ssf that you have just saved to a disc, click on 

Survey > Interview. The following screen will appear: 
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Note that the Interview 

window is automatically 

positioned in the first tab 

where a new record can be 

entered, this is because the 

database is empty, showing 0 

records. 

 

Next, introduce the following data in the fields indicated in the following tabs: 

In the tab General 

 

 

In the tab Personal 
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In this record, Mary Ross has two children, so we will put in two new records in the 

family table (age and gender). To do this, click on the <Age and Gender> button and 

a new form will be shown where we can input the new data. 

 

Click on <Save> and then click on <New> and the following record is introduced: 

 

Click on <Save> and click on [X] to close this window table and return to the main 

window. 

In the tab C. Other information 

 

And click on <Save> to save the first record. 

 

5.3 How to copy the template and data to the Pocket 

PC 

This section shows that the template generated and the data captured in the PC are 

compatible to work in the PDA. Next we will explain two different ways to exchange 

data between the PC and the PDA. 

5.3.1 How to copy data using activeSync 

To be able to copy files from the PC to the Pocket, the computer must have Microsoft 

ActiveSync 4.2 or a higher version installed. 
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Connect the Pocket to its cradle and the cradle cable to the USB connector on your 

computer. Switch on the Pocket and, if the Microsoft ActiveSync is installed, 

synchronize the files. 

 

A new window should then 

appear asking you to Set Up a 

Partnership; select Guest 

partnership and press Next> 

 

 

In Microsoft ActiveSync click 

on Explore. 

The Mobile Device window will 

now appear. 

 

Create a new folder in the Pocket, into which you will copy the template file. 

 

In the Folders list in the left 

panel of the window, click on 

the Mobile Device icon and, in 

the right panel, right-click in 

an empty area and select New 

Folder from the Menu. 
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By default, this gets the name ‘New Folder.’ Rename it Sample survey in the blue 

box. 

  

 

 

 

The new folder where 

you will copy the file 

should now be ready. 

Look for the file Survey 

Demo.ssf in C:\Sample 

survey on the 

computer’s hard disk. 

 

 

Copy it using Explorer. 
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Paste it into the Pocket: 

Using the Explorer browser, 

go to the Pocket folder My 

Documents\Sample survey 

and right-click on Paste. 

 

 

 

When the File Conversion 

window appears, click on 

OK.  

 

 

As shown in the window, the 

file has been pasted. 

 

5.3.2 How to copy data using an external device 

If the PDA has an external storage device, and this device can be read by the PC, 

then you can use this device. Normally PDAs have integrated CompactFlash (CF) 
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and/or Secure Digital (SD) slots that offer an alternate means of storage. In the case 

of the Pocket, it is strongly suggested that you use these cards to save the dynamic 

information instead of saving it to the internal PDA memory. 

 

To copy data from the 

PC to a CF or SD card, 

first connect the 

external device and 

using Windows 

Explorer, locate the 

template and the data 

in the PC, select and 

copy them. 

 

 

Next, place the cursor 

on the external card, 

select where you want 

to save your files and 

save them there. 
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Once the files have been 

copied, remove the external 

card from the PC and connect 

it to the PDA to be able to 

read them using the Pocket 

version of SSF. 

 

5.4 How to capture records in the Pocket 

Next, you will record data using the template that you simply pasted into the Pocket.  

 

To collect data from a template, first 

load the program that will read it. 

This is done through the 

Socioeconomic Survey Form, which 

has to be correctly installed in the 

Pocket. If not done yet, do so by 

means of the installation guide. 

Once the SSF file is installed in the 

PDA, load the program. In the 

Pocket click on Start and then on 

Programs. 
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From Programs, find and open the 

icon that corresponds to 

Socioeconomic Survey Form. 

 

 

Load the SSF program, click on 

Tools and on the option Load 

template to read the template file. 
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In the Open window you can view 

all files of the Socioeconomic Survey 

type; in this case there is only one, 

click on it and open Survey Demo. 

 

 

The screen appears divided in three 

tabs, as designed in the previous 

template. In the first tab (General) 

there are three filled fields and in 

the lower part of the screen you can 

find the 1/1 label that means that 

we are located in the first item of a 

total of one. 

 

 

To enter another record in the 

Pocket, click on <New> and enter 

data into the fields as shown in the 

figure. Then click on the Personal 

tab to enter data for questions 

there. 

 

 91 



 

In the Personal information section 

you will see blank question fields 

that you should complete with new 

data, as shown in the figure. Scroll 

down to additional questions using 

the vertical scroll bar on the right. 

 

 

At the end of this section of 

questions there is an Age and 

gender button. This brings you to a 

table with new questions, where 

you can record data on the 

respondent’s family. 

Click on the Age and gender button. 
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Now you are in the ‘Family’ table 

where you can enter age and 

gender data relating to the children 

of the respondent. If the person 

has X number of children, you 

should record X number of records. 

Enter the desired data and click on 

the Save button located in the 

lower part of the screen. 

 

 

 

After saving the data, the menu 

appearing in the lower part will 

change the display options. 

To close this table and return to the 

main recording area, click the close 

button (X) in the upper right of the 

screen. 
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Return to the main data collection 

area. To save the data click on the 

Save menu. Note in the lower menu 

that a legend reading <2/2> appears; 

this means you see a record which is 2 

of a total of 2 records. 

So far you have entered one record in 

the Pocket. 

 

 

As you have two records into the 

survey, this section is finished; you 

do not need to enter more data and 

can close the program. Go to 

Tools>Exit to exit the program (and 

free up the memory). 
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5.5 How to export data 

Once the data capturing has been concluded, the next logical step is to export the 

data. For this you will need to put the data in a different program that allows you to 

analyze all the data in the questionnaires that have been captured. 

In the previous section we updated the database using the Pocket to record a new 

survey. We need to copy the latest version to the PC to have access to the most 

updated data. 

Copy the data from the Pocket to the PC as you did before when copying data from 

the PC to the PDA. The data captured is saved in the same folder as the template; 

for the Pocket this is My Documents\Sample survey and for the PC it is C:\Survey 

demo. 

 

There are three files in the folder, one is 

the template that you used to capture 

data, and the other two are the XML files 

that contain the captured data. The data 

files are always going to have the name 

of the template, that is, Survey 

Demo.xml and Survey DemoT.xml. The 

first stores the data of the principal table 

and the second stores all the other tables 

that are generated (in this case only one 

table that is called family). 

 

Once the data files have been copied to the computer, you are ready to export the 

data to a more specific format like CSV, Excel or SPSS. This can be done using the 

SSF program, PC version. 
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On the computer, run the 

SSF program; once the 

program is loaded open 

the template 

C:\Surveydemo\Survey 

demo.ssf, and select the 

option Survey > Interview 

from the main menu. Now 

select Tools > Export… 

 

The following window opens immediately. 

 

The Export window shows all 

the tables available and the file 

formats permitted. 
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From the Tables list select all 

the tables and in Export file 

type select the option SPSS 

Syntax. 

 

Click on <Export selected tables> and you will then get a message confirming the 

operation has been successful. 

 

Repeat the process, but this time for the MS Excel file type. Close the Export window 

by clicking on [X] and return to the main window. So far you have exported all the 

data to SPSS and Excel. You can view the list of files generated by opening the folder 

using Windows Explorer. 
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If the statistical software SPSS is already installed, all .sps files will be automatically 

recognized. When you export the data to SPSS, you generate new files with names 

that correspond to the names of the data tables. If you export data to SPSS, two 

files are generated for each data table, one with .csv extension and one with .sps. 

These are needed for the SPSS program to import the data. 

Open the file principal.sps by double click on it. Next figure shows the syntax file 

loaded into the SPSS program. 

 

This is the window that 

shows the SPSS Syntax 

Editor. Different 

instructions of SPSS are 

present such as Get Data, 

Variable Labels, Value 

Labels, Missing Value, 

Frequencies Variables, and 

Descriptive Variables. 

 

 

To run the syntax, click on 

the menu Run > All. 

Note: this syntax is compatible with the SPSS version 10 or higher. If this needs to 

be run with a lower version, use this version’s syntax and make the required 

modifications. 

The syntax generated by the SSF contains commands for getting data from the 

principal.csv file and also generates statistical procedures of frequencies and means. 
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You can also see that the Data Editor window contains the labels of the variables and 

of the categories. 

 

So far we have briefly reviewed some of the SPSS functions. Next, we shall load the 

exported data for MS Excel. Again, you can load the principal.xls file by double 

clicking using Windows Explorer. The following figure shows the file loaded in 

Microsoft Excel. 

 

Notice that the first row is reserved for the name of the variable, and also includes 

the label of the variable in commentary mode. Row two shows the longer label of the 

variable. The third row includes the label of the codes for the definined variables 

(comboCtrl, radioCtrl and checkCtrl) visible as commentary. From the fourth row on 

you can see the captured values. 
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In this sample template we have been working with a table called family, and we 

have said that it is linked to the principal table through the idNumber field, as you 

can see in the following figure. 

 

Notice that the first two rows of family data correspond to the first row of data from 

principal where both tables are associated with the value 1 for idNumber. 
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6. A template’s syntax 

The syntax of the template is presented to show how the questionnaire form is 

structured and to familiarize the user with its sections. Usually, the template is 

viewed using the Socioeconomic Survey Forrm for PC program, but if you don’t have 

it, you can open the template with any text editor and explore and modify its parts. 

The template is an XML-code file that interprets the Socioeconomic Survey Form 

programs, and the corresponding file extension is .ssf. 

General definition: 

<XML> 

 <application> 

 <forms> 

  <form> 

   <control> 

    <categories> 

     <category> 

    <exitScript> 

     <script> 

<XML> 0 Root 

<application> 1 Application 

 This tag is mandatory and unrepeatable 

 Attributes: autoKeyboard, id, databaseName 

Description: The value of the XML mark <application> is used as the title to be 

shown on top of the Pocket screen and in the title bar on your PC, once the template 

has been loaded. 

The “autoKeyboard” attribute refers to the Pocket's keyboard. If the value is “True,” 

the keyboard is automatically shown when you are in an edit field (text field). The 

value “False” does not show the keyboard automatically, but it is necessary to 

activate it manually by clicking on its icon. 

- This attribute is mandatory 
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The “id” attribute refers to the key field of the application data (database). For 

example, the value id=”idenProd” means that the idenProd field of the database acts 

as the key field. Records can be found easily by using any database manager, and 

the key field prevents any duplication; i.and.,there cannot be two records in the 

database with the same value in the idenProd field. The value of the “id” attribute 

must exist in the <control> section referred to in the name attribute, and it may 

only be type=”alpCtrl” or type=”numCtrl.” 

- This attribute is optional 

The “databaseName” attribute is specified with the name XML node that will contain 

the main records to conduct the survey. If the attribute is left out, the "principal" 

value will be taken by default. 

- This attribute is optional 

<forms> 2 Forms 

 This tag is mandatory and unrepeatable 

Description: Forms Section 

<form> 2.1 Form 

 This tag is mandatory and repeatable 
 Attributes: title 

The “title” attribute shows the title of the tab. 

- This attribute is mandatory 

<control>2.1.1.1 Control 

 This tag is mandatory and repeatable 
 Attributes: type, name, caption, questionText, posControl, maxLength, range, 

default 

 The “type” attribute specifies the following types of controls: 

labelCtrl Displays a label. 

alpCtrl Displays an edition field that, in the capture, allows all kinds of 

characters. 
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numCtrl Displays an edition field; it allows only numbers from 0 to 9, and the 

decimal point. 

checkCtrl Displays a false/true-type verification box. The unchecked box is false 

(0), and the one checked is true (1). 

radioCtrl Displays a "Select an option"-type list. 

comboCtrl Displays a "Select an option"-type dropdown list. 

tableCtrl Displays a button, and by clicking on it sends it to be entered in a table 

with the name that corresponds to the “name” attribute. 

-  This attribute is mandatory 

The “name” attribute specifies the name of the variable where the recorded value is 

stored. Note that the type=”labelCtrl” does not require a variable name because it is 

not part of the database; it is only used to show titles on the screen. 

- This attribute is mandatory except for type=”labelCtrl.” 

The attribute “questionText” is the text of a control that is printed on the screen. 

This attribute is the raison d’être of a labelCtrl. It may be blank text in a checkCtrl if 

this suits our design needs. It represents the title of the table in a tableCtrl. 

- This attribute is mandatory. It applies only to type labelCtrl, checkCtrl, and 

tableCtrl. 

The “caption” attribute is used to place the VARIABLE LABELS on the SPSS syntax 

when you decide to export the data in the Socioeconomic Survey design program. 

- This attribute is optional. It doesn’t apply to labelCtrl and tableCtrl. 

The “posControl” attribute specifies the numeric coordinates of the screen where the 

capture control is shown. Its position (x, and) and size (width and height) of the 

control must be specified. Its format is x, and, width, height. The following figure is 

an example. 
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posControl=’80,40,100,24’

(0,0)

x=80
y=40

width=100

h
eig

h
t=

2
4

 

- This attribute is mandatory. 

The “maxLength” attribute specifies the maximum number of characters that may be 

entered in the type=”alpCtrl” and type=”numCtrl” controls. 

- This attribute is optional. It applies only to type=”alpCtrl” and type=”numCtrl”. 

The “range” attribute indicates the number values allowed for the type=’numCtrl.’ 

For example, range=’1..9,15..30’ means that the user may only enter values from 1 

to 9, and from 15 to 30. Valid ranges may also be: 

range=’1..9,15..’, allows you to enter values from 1 to 9, and from 15 and up. 

range=’..9’, allows you to enter values less than or equal to 9. 

- This attribute is optional. It applies only to type=’numCtrl’. 

The “default” attribute is useful to start the values of the controls, such as: 

alpCtrl Starts the control with a text chain. 

numCtrl Starts the control to a number value. 

checkCtrl If default=”True” starts the verified control. 

radioCtrl If the value of the default attribute matches one on the element list 
<category>, this button will be enabled. 

comboCtrl If the value of the attribute belongs to one of the list <category>, the 

comboCtrl displays that element. 

- This attribute is optional 
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Please find below some step-by-step examples 

Example 1: Use of tabs and labels. 

<?xml version="1.0" encoding="utf-8"?> 

<XML> 

<application autoKeyboard='False'>Example 1</application> 

 <forms> 

  <form title='General'> 

   <control type='labelCtrl' posControl='10,10,140,15' questionText=’General Information’ </control> 

  </form> 

  <form title='Personal'> 

   <control type='labelCtrl' posControl='10,10,140,15' questionText=’Personal Information’ </control> 

  </form> 

 </forms> 

</XML> 

 

 

Example 1 shows a form with two tabs with 

the automatic keyboard disabled. The title 

of the form is “Example 1” and the tab’s 

titles are “General” for tab 1 and “Personal” 

for tab 2. 

 

 

 

 

Example 2. Use of alpCtrl control. 

<?xml version="1.0" encoding="utf-8"?> 

<XML> 

<application autoKeyboard='False'>Example 2</application> 

 <forms> 
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  <form title='General'> 

   <control type='labelCtrl' posControl='10,10,140,15' questionText=’General Information’ /> 

   <control type='labelCtrl' posControl='10,30,40,15' questionText=’Place’ /> 

   <control type='alpCtrl' name='place' posControl='50,30,120,15' maxLength='10' /> 

  </form> 

 </forms> 

</XML> 

 

 

Example 2 shows a form where you can 

enter any text, and you are restricted to 

entering 10 characters or under. 

 

 

Example 3: Use of the numCtrl control. 

<?xml version="1.0" encoding="utf-8"?> 

<XML> 

<application autoKeyboard='True' id='ID'>Example 3</application> 

 <forms> 

  <form title='General'> 

   <control type='labelCtrl' posControl='10,10,140,15' questionText=’General Information’ /> 

   <control type='labelCtrl' posControl='10,30,20,15' questionText=’Id’ /> 

   <control type='numCtrl' name='ID' posControl='30,30,40,15' range='..99'/> 

   <control type='labelCtrl' posControl='10,55,30,15' questionText=’Age’ /> 

   <control type='numCtrl' name='age' posControl='50,55,50,15' default='15'/> 

  </form> 

 </forms> 

</XML> 
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Example 3 shows a form with two numeric 

edition fields. Because of the 

autoKeyboard=’True’ attribute, by placing 

the cursor on any of the edit fields, the 

keyboard appears automatically on the 

screen. Note that in each new record, the 

name=’age’ field starts at 15 because it 

has been set to do so in the default 

attribute. 

 

 

The numeric field is set to accept values 

at a range no higher than 99. 

 

Also, since the attribute id=’ID’ is in place, 

the system established the ID field as the 

key field. If you try to add a value to the 

database which is already there, the 

system will not save the data. This way, 

values are not duplicated in the ID field. 

If you want the values to be duplicated, all 

you have to do is to delete the id attribute 

of the tag <application>. 
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Example 4. Use of the checkCtrl control. 

<?xml version="1.0" encoding="utf-8"?> 

<XML> 

<application autoKeyboard='False'>Example 4</application> 

 <forms> 

  <form title='General'> 

   <control type='labelCtrl' posControl='10,10,140,15' questionText=’General Information’ /> 

   <control type='checkCtrl' name='married' posControl='10,30,115,15' 

    questionText=’Are you married?’ /> 

   <control type='checkCtrl' name='readWrite' posControl='10,50,150,15' default='True' 

    questionText=’Can you read and write?’ /> 

  </form> 

 </forms> 

</XML> 

 

 

This shows two verification-box-type 

questions. To answer "yes" to this kind of 

question, check the box. Note that every 

time you generate a new record, the 

question Can you read and write? is always 

checked. 

 

<categories> 2.1.1.1.1 Categories 

This tag is mandatory. It applies to type=”radioCtrl” and type=”comboCtrl” only, and 
is unrepeatable. 
 
Description: Category Section 

<category> 2.1.1.1.1.1 Category 

- This tag is mandatory and repeatable 

- Attributes: position 

Description: It shows the different options for this kind of question. 
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The “position” attribute helps you to locate on the screen the option list within the 

posControl framework, stated in the type=’radioCtrl’ controls. Their position is 

related to the framework, and the format is “x, y, width, height”. 

- This attribute is mandatory. It applies to type=”radioCtrl” only. 

Example 5. Use of radioCtrl control. 

<?xml version="1.0" encoding="utf-8"?> 

<XML> 

<application autoKeyboard='False'>Example 5</application> 

 <forms> 

  <form title='General'> 

   <control type='labelCtrl' posControl='10,10,140,15' questionText=’General Information’ /> 

   <control type='labelCtrl' posControl='10,30,75,15' questionText=’Marital status’ /> 

   <control type='radioCtrl' name='maritalS' posControl='10,50,100,45' default='Married'> 

    <categories> 

     <category position='0,0,100,15'>Single</category> 

     <category position='0,15,100,15'>Married</category> 

     <category position='0,30,100,15'>Widower</category> 

    </categories> 

   </control> 

  </form> 

 </forms> 

</XML> 

 

 

This shows a radio-type option list. From 

this list, it is possible to choose only one 

option. Note that we have selected by 

default the option Married, every time a 

new record is generated. The default 

attribute of the element <control> is 

optional, if you do not use it, none of the 

radio-button-type option list will appear 

checked for each new record. 
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Example 6. Use of comboCtrl control. 

<?xml version="1.0" encoding="utf-8"?> 

<XML> 

<application autoKeyboard='False'>Example 6</application> 

 <forms> 

  <form title='General'> 

   <control type='labelCtrl' posControl='10,10,140,15' questionText=’General Information’ /> 

   <control type='labelCtrl' posControl='10,30,135,15' questionText=’Type of land ownership’ /> 

   <control type='comboCtrl' name='tenure' posControl='145,30,95,15' default='Sharecropped'> 

    <categories> 

     <category>Own land</category> 

     <category>Land rented</category> 

     <category>Sharecropped</category> 

    </categories> 

   </control> 

  </form> 

 </forms> 

</XML> 

 

 

This shows a form with a combo-box list 

entry. You may only select one item. The 

selected option is the Sharecropped one, 

by default.  

 

<exitScript>2.1.1.1.2 Scripts 

This tag is optional and unrepeatable. 

Description: Section of scripts that help you to validate the response to a command. 

Once you have entered the last value, it will move to another command. 

The XML element <exitScript> does not apply to labelCtrl, alpCtrl, dateCtrl, and 

tableCtrl. 

<script> 2.1.1.1.2.1 Script 

 This tag is mandatory and repeatable 
 Attributes: type, condition, targetName 
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Description: Statement of the validation and skip script. 

The “type” attribute states the type of validation. Its possible values are: 

skipTo If the condition is true, skip to the command specified in the targetName. 

This is useful when you want to skip everything to get to an entry 

command that is located far away or under a different tab. 

message If the condition is true, the screen will show a message specified in the 

targetName, and the entry goes back to the command. 

disabled If the condition is true, it disables the command(s) set on “targetName.” 

Its syntax is “control1;control2;...;controlN.” 

- This attribute is mandatory 

 

The “condition” attribute helps you to establish the validation target condition. The 

condition depends on the type of control you are validating, but every time it is 

evaluated as true, the targetName is processed. The general syntax for “condition” is 

“nameControl1:status;nameControl2:status,,,nameControlN:status”. 

Depending on the command, status may be True/False for checkCtrl, text for 

radioCtrl and comboCtrl, and (>/</=) value for numCtrl. Remember that with XML  

use &lt; to represent the symbol < and &gt; for the symbol >. Other special 

characters are &quot;, &amp; and &apos; that represent the symbols ", & and ' 

respectively. 

- This attribute is mandatory 

The “targetName” attribute is executed depending on the type attribute, and every 

time the condition is met. 

- This attribute is mandatory 

To understand how the script is encrypted, the following examples are given for each 

command. 
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Example 7. Use of type=”disabled” scripts. 

<?xml version="1.0" encoding="utf-8"?> 

<XML> 

<application autoKeyboard='False'>Example 7</application> 

 <forms> 

  <form title='General'> 

   <control type='labelCtrl' posControl='5,10,140,15' questionText=’General Information’ /> 

   <control type='checkCtrl' name='haveSilo' posControl='5,30,230,15' 

     questionText=’Do you have silos to store your corn?’ 

    <exitScript> 

     <script type='disabled' condition='haveSilo:True' targetName='noSilo'/> 

    </exitScript> 

   </control> 

   <control type='labelCtrl' posControl='20,50,180,15' questionText=’How many silos do you have?’ /> 

   <control type='numCtrl' name='qSilo' posControl='200,50,40,15'> 

    <exitScript> 

     <script type='disabled' condition='qSilo:&lt;3' targetName='cap3'/> 

    </exitScript> 

   </control> 

   <control type='labelCtrl' posControl='20,70,190,15' questionText=’Of which capacity?’ /> 

   <control type='comboCtrl' name='cap1' posControl='20,90,45,15'> 

    <categories> 

     <category>100</category> 

     <category>200</category> 

     <category>500</category> 

    </categories> 

   </control> 

   <control type='comboCtrl' name='cap2' posControl='80,90,45,15'> 

    <categories> 

     <category>100</category> 

     <category>200</category> 

     <category>500</category> 

    </categories> 

   </control> 

   <control type='comboCtrl' name='cap3' posControl='140,90,45,15'> 

    <categories> 

     <category>100</category> 

     <category>200</category> 

     <category>500</category> 

    </categories> 

   </control> 

   <control type='labelCtrl' posControl='5,120,190,15' 
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    questionText=’If you do not have a silo, why not?’ /> 

   <control type='alpCtrl' name='noSilo' posControl='5,140,200,20' maxLength='80'/> 

  </form> 

 </forms> 

</XML> 

 

 

The previous code shows the 

type=’disabled’ use in the scripts. If the 

question “Do you have silos to store your 

corn?” is true (haveSilo:True), then the 

question “If you do not have a silo, why 

not?" (noSilo) is overridden. Likewise, if 

the answer to question "How many silos do 

you have?" is less than three (qSilo:<3), 

then it disables the third list box (cap3) 

that refers to the silo’s capacity. 

 

Example 8. Use of type=”skipTo” scripts. 

<?xml version="1.0" encoding="utf-8"?> 

<XML> 

<application autoKeyboard='False'>Example 8</application> 

 <forms> 

  <form title='General'> 

   <control type='labelCtrl' posControl='10,10,140,15' questionText=’General Information’ /> 

   <control type='labelCtrl' posControl='10,30,40,15' questionText=’Gender’ /> 

   <control type='comboCtrl' name='gender' posControl='10,50,70,15'> 

    <categories> 

     <category>Male</category> 

     <category>Female</category> 

    </categories> 

    <exitScript> 

     <script type='skipTo' condition='gender:Male' targetName='nameM'/> 

     <script type='skipTo' condition='gender:Female' targetName='nameF'/> 
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    </exitScript> 

   </control> 

  </form> 

  <form title='Male'> 

   <control type='labelCtrl' posControl='10,10,140,15' questionText=’Information on the man’ /> 

   <control type='labelCtrl' posControl='10,30,150,15' questionText=’Name’ /> 

   <control type='alpCtrl' name='nameM' posControl='10,50,150,20' maxLength='80'/> 

 

   <control type='checkCtrl' name='farmer' posControl='10,80,215,15' questionText=’Are you farmer?’ /> 

  </form> 

  <form title='Female'> 

   <control type='labelCtrl' posControl='10,10,160,15' questionText=’Information on the woman’ /> 

   <control type='labelCtrl' posControl='10,30,150,15' questionText=’Name’ /> 

   <control type='alpCtrl' name='nameF' posControl='10,50,150,20' maxLength='80'/> 

   <control type='checkCtrl' name='housewife' posControl='10,80,215,15' 

    questionText=’Are you housewife?’ /> 

  </form> 

 </forms> 

</XML> 

This example shows the type=’skipTo’ use in the scripts. If you select Man in the 

“Gender" question of the General tab, the control skips to the "Name" question of 

Male tab (condition='gender:Man’ targetName='nameM'). Likewise, if you select 

Female in the "Gender" question, you will skip to the "Name" question of the Female 

tab (condition='gender:Female’ targetName='nameF'). 
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Example 9. Use of type=”message” scripts. 

<?xml version="1.0" encoding="utf-8"?> 

<XML> 

<application autoKeyboard='False'>Example 9</application> 

 <forms> 

  <form title='General'> 

   <control type='labelCtrl' posControl='5,10,140,15' questionText=’General Information’ /> 

   <control type='checkCtrl' name='haveSilo' posControl='5,30,230,15' 

    questionText=’Do you have silos to store your corn?’ 

    <exitScript> 

     <script type='disabled' condition='haveSilo:True' targetName='noSilo'/> 

    </exitScript> 

   </control> 

   <control type='labelCtrl' posControl='20,50,180,15' questionText=’How many silos do you have?’ /> 

   <control type='numCtrl' name='qSilo' posControl='200,50,35,15'> 

    <exitScript> 

     <script type='message' condition='haveSilo:False;qSilo:>0' 

      targetName='This answer conflicts with previously entered data ("Do you have silos to store 
your corn?").'/> 

    </exitScript> 

   </control> 

   <control type='labelCtrl' posControl='20,70,190,15' questionText=’Of which capacity?’ /> 

   <control type='comboCtrl' name='cap1' posControl='20,90,45,15'> 

    <categories> 

 115 



     <category>100</category> 

     <category>200</category> 

     <category>500</category> 

    </categories> 

   </control> 

   <control type='comboCtrl' name='cap2' posControl='80,90,45,15'> 

    <categories> 

     <category>100</category> 

     <category>200</category> 

     <category>500</category> 

    </categories> 

   </control> 

   <control type='comboCtrl' name='cap3' posControl='140,90,45,15'> 

    <categories> 

     <category>100</category> 

     <category>200</category> 

     <category>500</category> 

    </categories> 

    <exitScript> 

     <script type='message' condition='qSilo:&lt;3' 

     targetName='It is not correct to select the capacity of a third silo if you have answered that you 
have less than three.'/> 

    </exitScript> 

   </control> 

   <control type='labelCtrl' posControl='5,120,200,15' questionText=’If you do not have a silo, why not?’ /> 

   <control type='alpCtrl' name='noSilo' posControl='5,140,200,20' maxLength='80'/> 

  </form> 

 </forms> 

</XML> 
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This example shows the use of the 

type=”message” script. As shown in 

Example 9, if the question "Do you have 

silos to store corn?" is false and you try to 

enter an amount higher than zero, the 

question "How many silos do you have?" 

will display a warning message. 

 

 

We have added to the template a second 

warning validation; i.and., you cannot 

enter the capacity of a third silo, if for the 

question "How many silos do you have?" 

you gave an amount lower than three. 
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7. Field use of PDAs and handling of the 

questionnaire 

This section contains a set of comments based on the field experience of surveyors 

that conducted the research project “Evaluación de impacto in comunidades of the 

Valles Centrales de Oaxaca” ("Impact Assessment Research in Communities of the 

State of Oaxaca, Mexico"). This practical and direct use of PDAs in the field with 

farmers allowed us to identify the advantages and disadvantages of their usage, as 

well as the usefulness of the present manual. Since interviewers were initially 

unfamiliar with this technology, interviewers had to be trained in the use of the PDA, 

and simplifications had to be made to the survey administered through the PDA, and 

problems occurring during start-up had to be solved. Hence the Oaxaca study also 

served to test the technology. The first surveys were recorded both on paper and in 

PDA, both to make sure no data were lost and to compare the effectiveness of the 

two methods. After an adsimplyment??? period, most surveyors adopted the PDAs. 

They were asked to mention the advantages of working with the Pocket, as well as 

its disadvantages and possible solutions or alternatives. The results are listed. 

7.1 Advantages 

The tools described in this manual are excellent for quantitative socioeconomic 

surveys, their main advantages being that they:  

 Save time by allowing data to be recorded rapidly at the time of the interview, 

and avoiding having to enter data later. 

 Allow more ready availability of data for analysis by allowing cross-checking in 

the field. 

 Permit verification of data at the time of the interview and correction of bias 

remaining from the field data collection. 

 Frequently allow data to be emailed from the field to the place where it will be 

stored and analyzed, in an electronic and verified form. 

 

The tools are primarily to capture socio-economic (household level) data, though 

other data can be recorded (agronomic, breeding-trial, pest-infestation data, etc.). 
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7.2 Disadvantages - solutions/alternatives 

Disadvantage 

 The application of the surveys is "cold:" when entering the data, the surveyor 

does not look the interviewee in the eyes, and therefore the interviewee loses 

interest. 

Solution/Alternative 

 Minimize the questions that require full attention from the surveyor on the 

Pocket, such as use of "alpCtrl" commands to enter the name of the 

interviewee, address, etc. 

 Familiarize yourself with the survey to be able to ask the questions without 

reading them from the Pocket. 

Disadvantage 

 It can be difficult to see the data on the screen for questions that have a table 

that is too big for the screen. As you scroll down or to the right, you will be 

unable to see the column headers and row names.  

Solution/Alternative 

 Insert a line and/or column when you can no longer see the column header or 

row name. Copy and paste the column header or row name in the space you 

made. This way you can see the column header information, for example, even 

as you scroll down the description of the data you are collecting will be visible. 

 Memorize your column headers or row names. This way, as you scroll down, for 

example, and can no longer see your column header, you will still understand 

the data entries.    

 Change the table into a relational database. In other words, keep the 

information on the table to a minimum. Create separate records for each entry.  
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Disadvantage 

 It is difficult to read the screen in sunlight (outdoors). 

Solution/Alternative 

 Avoid the direct sunlight by placing yourself under the shade of a roof or a tree. 

Disadvantage 

 The Pocket battery does not last more than three surveys. 

Solution/Alternative 

 Have at least one backup battery, and verify that it is charged before every 

survey. 

Disadvantage 

 It is difficult to enter qualitative data. 

Solution/Alternative 

 It is recommended you have a notepad with you to write down answers to 

qualitative questions. These can later be transferred to the Pocket. 

Disadvantage 

 If the survey is not properly designed, there is the risk of not entering the right 

information in the field. 

Solution/Alternative 

 You must first test the survey in the field and subsequently on paper; the 

survey is designed to incorporate the changes into the Pocket. The survey is 

applied again in the field and the design of the questionnaire will better capture 

the data you need to collect.  
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Disadvantage 

 When conducting a survey the respondent gives information that needs to be 

converted or estimated. I cannot record this type of information because the 

Pocket does not allow me. 

Solution/Alternative 

 If the respondent provides you with information that cannot be recorded 

directly into the Pocket because a conversion or estimation is needed, write 

them down on a notepad, for later conversion and recording in the PDA. 
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